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1. Introduction

1.1 Welcome!

Dear User,

You have just successfully installed your new CD Writer as a read drive.

In order to be able to provide you with up-to-date information in a form that will allow you to
concentrate solely on what you want to know, we have designed the second part of the
manual as an HTML text. This contains links that will immediately take you to precisely those
sections of the manual that you want to go to. In addition, it helps us to rapidly integrate last
minute changes into the manual for each new release of the software CD - translation into 15
languages apart - so that we can always offer you the very latest information. Of course, the
second part of the manual is also available as a consecutive text (with extension .TXT) on the
CD. The manual for the WinOnCD recording software is also stored on the CD. In future, we
will try to integrate links for this manual too.
It goes without saying that you will always be welcome to call our hotline at no cost to yours-
elf except the usual Telecom rates. Mitsumi provides this hotline support as a free customer
service. All we ask is that you assist our hotline staff by supplying full and detailed informati-
on (even if you think this is unnecessary) as described in the Support chapter. If you are not
satisfied with the support service, please do not hesitate to tell us why, either by fax (+49
1805 213751) or e-mail (Support@Mitsumi.de). Neither our headquarters in Neuss, Germany,
nor our subsidiaries in France and England have the capacity to process support calls. So plea-
se always address your queries exclusively to our hotline, by phone, fax or e-mail. Any sugge-
stions for improvement will always be welcome.

The following chapters frequently contain references to Windows. If no further explanations
are given, this will always be the current version of Windows, i.e., Windows 95/98 or Windows
NT 4.0. If a particular piece of information refers to one specific operating system only, this
will be indicated.

And now you're all set to go!

Have fun with your new Mitsumi product.

Your Mitsumi Support Team
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1.2 Safety Notes

Please observe all warnings and safety notes given in this manual to avoid any damage to
your device or personal injury.

Before attempting to remove the cover from your computer, please always disconnect the
power cord from the wall socket. Do not try to service or repair your drive yourself. There are
no internal parts requiring maintenance. It is not possible to repair the drive without spare
parts, special tools and sophisticated equipment (to readjust the drive after repair). Opening
the CD Writer can expose you to dangerous power surges, laser beams or other risks. If you
operate the device with the cover off and happen to look into the invisible laser beam, this
will cause irreparable damage to your retina and permanently impair your vision! If any main-
tenance or repair becomes necessary, this must at all times be carried out by an authorized
dealer or wholesaler. Please also remember that opening the device automatically invalidates
the warranty.

Another point to remember is that the noise level of audio CDs is lower than that obtained
with another analog audio source (*.WAV or *.MID files).

1.3 License Notes

Licenses and trademarks: All product names mentioned in this manual are either trademarks
or registered trademarks of the respective manufacturers, which is expressly acknowledged
here. The contents of this manual are subject to change without prior notice according to the
information available at the time; neither the seller nor the manufacturer can be held liable
for this. The software described in this manual was supplied in compliance with a license agre-
ement and can only be used or reproduced according to the provisions of this agreement.

Neuss, December 1998
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2. Is my PC suitable for use with a CD Writer?

In this section we would like to help you investigate whether your PC is suitable for recording
CDs. This is not so much a question of the minimum hardware requirements, but rather the
configuration options on your PC which might prevent successful recording.

The following deserve a special mention:
- installed DOS drivers
- installed Busmaster drivers under Windows 95/98
- inadvisable settings in your PC's BIOS system, and
- concurrent installation of different recording software programs.

2.1 DOS CD-ROM or Busmaster drivers

Installed DOS drivers, allowing the recorder to be run at the genuine DOS level (not Windows
DOS box), and Busmaster drivers for hard disk controllers under Windows should not be instal-
led. Both types of drivers can prevent successful recording under Windows 9x. We therefore
recommend removing both types of drivers, in the event that they have been installed. Neither
the DOS driver nor the Busmaster driver are automatically loaded by Windows 95, and must
therefore be installed manually by the user.
You can deactivate the DOS driver by inserting "rem" at the beginning of the respective line in
the config.sys file (enter: device=c:\mtm\mtmcdai.sys..., etc.) or in the autoexec.bat file (enter:
c:\windows\command\mscdex.exe.., etc.). The drivers will then no longer be installed when you
reboot your PC.
To remove the Busmaster driver you will need the setup routine on the diskette that was sup-
plied with your motherboard. Run the setup program and select driver removal. For more
details, please consult your motherboard manual or the readme files on the driver diskette.

2.2 BIOS settings

We recommend adjusting some of the settings in your PC BIOS system. Normally the PIO mode
for Atapi devices will automatically be recognized when you boot your PC. However, it is advis-
able to set the PIO mode permanently to option 3 in the setup program. To do this you will
have to run the PC setup program. To access setup, press the DEL key or F1 when starting up
your computer. Consult your motherboard manual to find out where and how to change the
setting.
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2.3 Interaction with other installed software

Before you install ToGo, make sure that there is no other recording software installed, irrespec-
tive of whether it is a CeQuadrat product (i.e., older versions of ToGo or WinOnCD, but not spe-
cific recording software such as JustAudio) or another make. Please remove any existing soft-
ware first and reboot your computer before installing the current version of ToGo!

3. How to handle the recorder and the recording media

The degree of success you will have recording CDs depends to a large extent on careful hand-
ling of the recorder and the CDR media, as well as the source CDs. Please therefore read the
following passages attentively.

3.1 How to handle the recorder

Do not drop or jog the drive. The lens and prism are very sensitive and can be damaged if the
device is wrongly handled. Avoid all impacts or jolts, especially while the device is recording,
otherwise you might lose not only the data that is just being recorded, but even previously
recorded data. Do not operate the CD Writer anywhere near water or other fluids and keep all
fluids away from the device. To clean the drive exterior, use only a clean soft cloth. If necessary,
dampen the cloth slightly, but REMEMBER: benzene or alcohol solutions may damage the sur-
face. Protect the device from dust or smoke: even with its dual dust protection, we cannot gua-
rantee that the Mitsumi CD Writer will be impervious to long-term exposure to such conditions.
At low temperatures or alternation between hot and cold environments, make sure that all
condensation has dried out from the PC and the Recorder and that the ambient temperature is
within the permissible limits of 5°C and 40°C.
Never set down any object heavier than 100g (e.g., a coffee cup) on the CD tray, otherwise you
may risk breaking it!

To get the best possible results, use only CDs which bear the following logo:

3.2 How to handle the media

Use only high quality CD Recordable disks from reputable manufacturers. The CD-R disks must
comply with the Orange Book Part II standard. Clean your CDs regularly with a cloth dampened
with water or CD cleaning fluid. Wipe in a straight line from the center outwards and never in
circles, as an arc-shaped scratch could render your CD unreadable. Make sure the CD is comple-
tely dry before inserting it in the drive. Always handle CDs by their edges. Never write on either
side of a disk with a hard object (e.g., ball-point pen or pencil). Even a scratch on the label side
can destroy data. If you absolutely must write on a CD, use only special marker pens available
from your computer dealer. Avoid using small labels because they will upset the balance of the
CD, causing vibrations which will result in read and write errors. Never expose the CD to direct
sunlight or hot, humid environments. Always store your CDs in their sleeves to prevent them
becoming dusty, scratched or damaged in any way. (These are the most common causes of
error messages and aborted CD recording operations!) Never bend CDs. –•
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4. Recorder Controls and Indicators

4.1 Front view

Front view
1. Open/close button: brief pressure on this button will open and close the tray.
2. Read/write monitoring LED (labeled R/W): Lights up green during reading and red during

writing operations. Active LED (labeled DISC) lights us when a CD is inserted, flashes at
intervals of two seconds until a newly inserted CD is recognized and at intervals of 0.5
seconds while a CD is being ejected.

3. Emergency eject: use only when the recorder is disconnected from the power supply.
4. Volume control for headphone output.
5. Headphone jack: this will allow you to plug in headphones or active loudspeakers using

a commercially available 3.5 mm pin connector.
6. CD tray: opens and closes when button 1 is pressed. A gentle tap against the open CD

tray will also close it.
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4.2 Emergency eject

Emergency opening of CD tray

Under certain circumstances, the CD tray may jam. Before doing anything else, switch the
recorder off and unplug the power cord from the wall socket. Straighten out a large paper clip,
as shown in the figure below. Carefully insert the tip of the paper clip into the small hole indi-
cated and gently push inwards until the CD tray slides out.
Never attempt to do this with the power on, otherwise you may damage the recorder.

5. Software Installation

5.1 Introduction

The CeQuadrat recording software program WinOnCD provided, consists of a CD and a possibly
included driver disk. When used together with Mitsumi CD Writers, it will allow you to record
and copy data and audio CDs, video discs and bootable CD's. It is very easy to install and
handle, as briefly described below.

In terms of installation and proper functioning the software makes very little demands on your
system. If you are using a Windows 9x PC, the minimum requirements are Pentium 75 with 16
MB RAM, for Windows NT 4.0 you will need 32 MB RAM. First make sure you have no other
recording software installed that might interfere with ToGo and vice versa, and correctly remo-
ve it, if necessary.

5.2 Installation

When the WinOnCD CD is inserted, the software setup program will normally run automatical-
ly. After a while, the following welcome window should appear. If it does not, run the program
“install.exe” in the CD root directory.
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To start the actual installation, press the “Next” button in the window. If you choose
“Cancel”, the installation routine will be aborted, without any changes being made to 
the system. Please read the product license agreement in the next window carefully and
accept this with “YES” or reject it with “NO”. If you press “NO”, the installation will 
again be aborted.
Once you have accepted the agreement by pressing Yes, you can select the directory to save
the program files to by pressing “Browse” or accept the default setting by pressing “Next”.

In the following window you will be asked to enter your name, company and the serial num-
ber of the software. You will find the serial number on the cover of the CD. Please keep the
CD cover in a safe place, since the serial number must be input whenever installation takes
place.

–•
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You must enter something in all fields. In the Name and Company fields, this may be anything
you like. When you press the “Next” button, the program will ask you whether all entries have
been correctly made. If you confirm this, and the serial number has been correctly input, instal-
lation will start. If you enter the serial number incorrectly, you will have the opportunity to
input the number correctly.

–•
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You can select the components to be installed in the next window.

After confirming the entry with the “continue” button, the copying process starts. When the
data has been copied to your hard drive, you must state whether a driver disk was enclosed
with the CD writer. This is only supplied, if an updated driver is issued after the software CD
has been produced.

–•
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If you have also selected the Packet CD component, installation of Packet CD will then begin.

Actuate the “continue” button and specify the storage location for Packet CD in the next win-
dow, then actuate “continue” again to start the copying process. When installation is comple-
te, reboot your PC. In the next window, state whether the computer is to be rebooted imme-
diately or later on.

5.3 Uninstall

The software can be uninstalled using the “Software” icon in the Windows system control
panel.
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6. Getting Started

6.1 Introduction

This chapter is intended as a short guide to help you record and copy data or audio CDs. To
make bootable or Video CDs, the procedure is listed in the online help, respectively the soft-
ware manual, which is located in the directory x:\Manual\WinOnCD (with x:\ being the drive
letter of you CD-ROM/ CDRs or CDRWs.
We assume that you will be familiar with the basic recording terminology. If this is not the
case, please refer to the detailed manual on the software CD which you will find in several lan-
guages in the above mentioned directory. This is an MS WinWord document that can be viewed
and printed with the viewer software provided.
To run WinOnCD, select START -> PROGRAMS -> CEQUADRAT -> WinOnCD.

After you have started WinOnCD, the program will open with a window asking you to select
the type of CD project you want to begin with. The choice offered is Data CD (ISO/Joliet
Format), Audio CD (CD Digital Audio), or the copy module (CD Copy).

Once you have chosen a project type, you can press the following icon to run a 
utility program, a so-called Wizard, which will explain the necessary steps for recording CDs.
Please also read “Tips & Tricks for Recording”, to avoid frequently made errors. –•
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6.2 CD Recording Wizard

If you are not familiar with CD recording routines, we recommend using the WinOnCD Wizard,

a small utility, to record your first few CDs. To run this, click on the Wizard icon in the
tool bar or select Start -> Programs -> CeQuadrat -> WinOnCD Wizard after you have started
WinOnCD.

The utility will guide you step by step through the process for producing a data CD or an
audio CD, and will show you how to use the CD Copy module. Use the Wizard until you feel
confident about going it alone!

6.3 Data CD

The following example demonstrates how to record a data CD in ISO 9660/Joliet Format. Think
of your own data, and the process will immediately become clear!
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6.3.1 Select a CD project in ISO 9660 / Joliet Format

Once you have selected the ISO 9660 / Joliet Format project option (data CD), which is nor-
mally the default setting, the WinOnCD main window will open. This consists of a source win-
dow (upper section) and a target window (lower section).

On the left side of the source window you will find a reference to the Joliet Format (Joliet file
system). If this is not the case, click the option “New” in the “File” menu and select “ISO
9660 / Joliet Format”.

6.3.2 WinOnCD main window

As already mentioned, the main window consists of two sections. The source window resem-
bles Windows Explorer, with a Drag&Drop data allowing you to drag the data you wish to
record into the target window. To drag and drop directories, select from the left hand side of
the source window, for single files, the right hand side, and drop the selected data in the right
hand section of the target window.

–•
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The target window offers you four buttons:

Tracks:

Shows how many tracks are already on the CD (for data CDs, this will normally just be one).

Editor:

Gives you the opportunity to “edit” files and directories you want to record, i.e., you can add
files and directories from the source window or delete them in the target window.

Artwork:

This is a utility allowing you to create labels and inlays for your CDs. For more information,
refer to the manual on the WinOnCD CD.

CD:

Opens the window with CD properties, Recording settings, and the Record button.
The source window operates exactly like Windows Explorer. The directory structure is shown on
the left hand side, files and their attributes on the right hand side. Practice opening and closing
the directories to get a feel for how to handle the source window.

–•
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If no directories or files have been selected for writing to the CD, the target window will show
the empty root directory. Simply drag a directory from the source window and drop it on the
symbol for the root directory in the target window. The selected directory will then appear in
the target window.

The first directory you have selected will be written to the root of the CD and all subdirectories
will be added. You can also add directories to any directory already contained in the target
window.

6.3.3 Writing to the CD

When you have finished preparing the contents and the structure of the CD, press the CD but-
ton to open the following window:

At present, all you need to do is to make sure all the options are selected as shown in the win-
dow. This will ensure proper recording. In the “Test Write” section of the window, you can sel-
ect the “Simulate writing only” option. This will simulate the recording to allow you to test
whether it would have been successful. Before you press the Record button, check that you
have inserted an unused CD blank in the recorder. Press the Record button to start recording or
testing. When this is completed, the system will return a message to report successful recor-
ding.

–•
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6.4 Audio CD

The following example describes how to record an audio CD. Many of the steps are similar to
those required for a data CD and will therefore be skipped here.

6.4.1 Select CD Digital Audio project

Select the “CD Digital Audio” project option either on start-up of WinOnCD or by selecting
“New” in the “File” menu. This will open the main window for audio CDs. Please check that
the target window is entitled “CD Digital Audio”. If not, then start the project again.

6.4.2 Select audio files

Use the Drag & Drop function to select .WAV files from your hard disk or the tracks of an
Audio-CD, and drop these in the target window.

It is not advisable to simultaneously record data from the hard disk as well as tracks from an
audio CD, since this will probably result in buffer under runs, interrupted data flow to the
recorder, and may render the CD blank unusable. If necessary, you can “extract” the CD tracks
and save them as .WAV files on your hard disk. Please remember that if you want to extract a
complete audio CD (74 minutes playing time), you will need about 750 MB free space on your
hard disk.
You can extract files from a CD using WinOnCD or any other special programs. The quality of
the resulting .WAV files will largely depend on the quality of the source CD-ROM (scratches,
dirt) and that of the source CD-ROM drive. Not all drives are capable of extracting the audio
tracks in sufficiently high quality. Please consult your manual or the drive manufacturer. –•
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6.4.3 Recording the audio CD

The write process is initialized in the same way as for data CDs. The write process can also be
simulated. To ensure that the audio CD can be played by commercially available CD players,
the session has to be properly closed.

6.4.4 Extracting audio tracks using WinOnCD

WinOnCD can be used to extract tracks from an audio CD and save them on the hard disk.
This is advisable when the source drive is slow in extracting audio data (audio data are
extracted at considerably lower speeds than “normal” data), or if you want to record a “Best
of ...” selection from several different audio CDs.
Insert an audio CD in a CD-ROM drive (this may even be the recorder itself). First select “CD
Digital Audio” and then open the “Preferences” window in the Options menu.
In the Preferences window, select the “Digital Audio Extraction” index card and activate the
option “Copy CD-DA source tracks ...”.

–•
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If you now add a track from an audio CD to your audio project, the system will first ask you to
enter a name and path before writing the track to your hard disk. Repeat this procedure to
extract tracks from several different audio CDs and then record them as a “Best of ...” selec-
tion.

6.5 CD Copy

The copy module allows you to create a backup for virtually any CD. To do this, lay the source
CD in a CD-ROM drive (not the recorder) and start a CD Copy project. The contents of the CD
will then be extracted. In rare cases, WinOnCD may attempt to extract the data from the
wrong drive. When this happens, drag the icon for the correct drive into the destination win-
dow and the data will then be extracted from there. For future CD copies, the program assu-
mes that the source CD will be in the last selected source drive.

Please note the following:

- the read drive should be fast enough, at least 8-speed.
- if the source CDs are dirty, scratched or faulty, frequent reading attempts will result in 

“buffer underrun” errors.
The actual recording process runs as described in the chapter on data CDs.

6.6 Packet CD

If you have also installed the “Packet CD” component during software installation, a window
opens when a blank CD (CDR or CDRW), in which you must specify whether the blank is to be
formatted in accordance with the UDF standard or whether WinOnCD is to be started.

If you decide to format the blank with Packet CD, you must initially state whether you wish to
format a CDR or a CDRW. Please note that it takes considerably longer to format a CDRW (up
to 45 minutes). The Packet CD can then be used in the recorder just like any other removable
medium (like a floppy disk), i.e. you can record data on the CDR/CDRW using Drag & Drop,
you can remove the Packet CD and insert it again later on. Prior to formatting, you can spe-
cify whether the data to be copied on the Packet CD is to be compressed “on the fly” (this
option is not available on all versions). It is thus possible to copy 1 GB of data onto a
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CDR/CDRW. Since this compression is not supported by all manufacturers, we recommend
that this option is only used, when the disk is not going to be used for an exchange of data.

CDs produced with Packet CD, are readable primarily on a writer (with activated compression
only in writers with Packet CD V3.0 or higher). By finalizing, the CDR/CDRW can be read in
every CD ROM under Windows 9x. There is only one restriction, and that is if your CD ROM is
normally unable to read CDRWs. If you want to finalize the CD, place the CDR/CDRW in the
writer, select in Windows Explorer the drive of the writer, activate the context menu with a
right mouse click, and from this then select “Finalize CD”.

After finalizing, the UDF CD can be read in every CD ROM under Windows 9x.

–•
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6.7 CD ReWritable (CDRW)

By comparison to a normal blank CD (CDR), rewritable CDs (CDRW) can be written to over
and over again. When producing the CDRW there is no real difference to a CDR. You simply
have the capability of deleting a CDR and thus writing on it again. Please note that the dele-
tion of a complete CDRW can take up to one hour, and that formatting with Packet CD can
take considerably longer.
To delete a CDRW. start “erase CDRW” in the “Recorder” menu.

In the subsequently appearing window, you must select from one popup menu, whether the to
erase the complete CDRW (time consuming) or just the “Table of Contents TOC” (fast erase),
with subsequent selection of “erase”.

Fast erase (only TOC): This only involves erasure of the Table of Contents TOC. For WinOnCD,
this CD then appears to be an empty disc, which can be overwritten. The data is then only
actually physically erased when they are overwritten. The erase process only takes a few
seconds. –•
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Erase complete CD: The completely written sector of a CD is overwritten here, i.e. the data is
physically erased. The erase process can then take up to 40 minutes.
Please note:
CDRW media, which are written with WinOnCD. can only be completely erased. The ISO file
system does not permit the erasure of individual files. Special software is needed for selective
erasure, such as Packet CD 2.0 or higher from CeQuadrat.

7. Tips&Tricks for Recording

The following notes can help you to avoid problems:
- Before recording, deactivate any screen savers you have running.
- Close all other applications.
- Use a high-speed hard disk (all new hard disks usually provide sufficiently high speed).
- Start ScanDisk to repair any disk errors.
- Defragment your hard disk.
- Disconnect your PC from any networks.

All the above notes will help to avoid “Buffer Underrun” errors. In certain cases, the data flow
to the recorder can be interrupted so often or slowed down until the recorder data buffer is
empty and the CD blank thus becomes unusable.

8. Support

The following sections contain advice on eliminating any problems you may encounter with
your Mitsumi device.

8.1 Before you call Technical Support....

If you experience problems with your CD Writer, please first carefully read through the
“Support” chapter. The most frequently encountered problems are listed here. We want you to
be satisfied with your Mitsumi writer and obviously want to help you resolve any problems
quickly. However, there are certain things you need to do before calling us. If you can provide
all the necessary information, our hotline staff will be able to solve most problems rapidly and
efficiently. But, the hotline staff depend very much on your cooperation. You act as their eyes
and ears by observing and describing what is happening while they try to solve your problem.
The information listed below will help our staff to identify the problem quicker. So, please do
make a note of all error messages you have seen.
Collect the following information in readiness for your call:
CD Writer model (you will find this on the specification sheet).
How is your recorder installed? IDE or SCSI, which IDE port, on the main board or the sound
board. What is the I/O address or IRQ, make and type of the SCSI controller, number and type
of any other devices connected to the SCSI bus, how they are terminated, etc.
The driver version. You will find this on the label of the installation disk provided.
The version of your operating system (Windows 95, NT, OS/2).
Brand and model of your computer.
Processor type and speed, e.g., Pentium II 300.
Extracts from your AUTOEXEC.BAT and CONFIG.SYS.
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8.2 How and when can I get technical support?

There are several ways of obtaining technical support. These are listed below in order of prefe-
rence:
1. World Wide Web - Visit us on the internet at our site http://www.mitsumi.de where you will

find the descriptions and trouble shooting solutions that we have collected to help you
solve or overcome your problem. Download the latest drivers, software, etc. If you have any
further questions, leave us a message and we will answer it as quickly as possible.

2. Fax us on +49-1805-213751.
3. Visit our mailbox (BBS) at +49-1805-213750 where you can download the latest driver 

versions.
4. Send us an e-mail to “support@mitsumi.de”
5. Call our hotline at +49-1805-212530 / +49-180/5001722: Mon-Fri 10:00 to 19:00 h CET,

Sat 13:00 to 19:00 h CET.

8.3 Trouble Shooting Guide/FAQ

This Chapter lists some of the standard errors that may occur during installation and initiali-
zing of your CD Writer and provides solutions. This will help you to eliminate simple problems
without having to call Technical Support. You can also find the most frequently encountered
installation problems and the related solutions on our WWW page (http://www.mitsumi.de).

First of all, run through the installation procedure again step by step to check that you have
followed all instructions correctly.

8.3.1 Error message: CDR 101 - “Drive X not found”

Error message: CDR 101 -”Drive X not found”
This may be due to an address or IRQ conflict, e.g., when you have two secondary IDE ports
(motherboard and sound board) in your computer. Deactivate the unused IDE port.
If you have just inserted a CD, wait a few seconds to see whether the CD “spins up” and then
try again.
Check whether there are any scratches, dirt or fingerprints on the CD. Check whether the CD
has been inserted label side up. Check that this is a CD-ROM and not an audio CD. The CD
Writer will play audio CDs, but these cannot be controlled using DOS commands.

8.3.2 Error message: CDR 103 - “Not ISO 9660 or High Sierra Format”

Error message: CDR 103 - “Not ISO 9660 or High Sierra Format”
The CD you have inserted may have been formatted for another computer or operating system
type, such as Macintosh or Sun, or does not contain any data in ISO 9660 format.
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8.3.3 Problems playing audio files

There are two types of sound for CD-ROMs.
1. CD Audio: data that is directly converted by the CD drive. All audio CDs and some CD-ROMs

use this type of sound. You can listen to the music on audio CDs by plugging headphones
or active loudspeakers into your CD drive.

2. Audio files: data (.WAV or .MID files) sent by the CD drive to the computer and converted
by the sound board. This type of sound can only be heard if you have a sound board instal-
led and have connected up the CD Writer’s audio cable to the sound board.

If the wrong cable was supplied, contact the sound board manufacturer.
• Music CDs: No sound from the loudspeakers.
But, the loudspeakers do function with other CD-ROMs, games or data CD-ROMs. In this case,
you definitely have a hardware problem, i.e., an incompatible or defective audio cable.
Replace the cable and the problem should be eliminated.
• Music CDs: No access possible.
Do not try to read an audio CD directory with the file manager. You cannot access any normal
CD-DA (audio CD) using this route. Windows provides the program “Media Player” for audio
CDs, and Windows 95 either “Media Player” or “CD Player”. If you cannot play any music CDs
at all, the audio driver MCICDA.DRV might either not be installed/loaded or may be defective.
Procedure for Windows 95:
1. Use the “START” menu on the desktop.
2. Select “SETTINGS”
3. Select “CONTROL PANEL”
4. Double click on “MULTIMEDIA”
5. Click on the “ADVANCED” folder
6. Double click on “MEDIA CONTROL DEVICE”
7. Double click on “CD AUDIO DEVICES (MEDIA CONTROL)”
8. Select the option “USE THIS MEDIA CONTROL DEVICE”
9. Restart Windows 95.
If this does not solve the problem, consult Microsoft.

9. Annex

9.1 DOS driver IDE Installation

The DOS drivers allow you to use the recorder as a read-only device at the DOS level. The dri-
vers do not have to be installed under Windows 95/NT as these operating systems come with
their own driver. Please note that DOS drivers must not be installed if you want to record a CD
as they will cause serious problems and that installed DOS drivers will negatively affect the
performance of Windows 95.
To install the driver, run the self-extracting archive. This will copy the extracted files to the
c:\Mitsumi directory and start the setup routine. The first page of the setup routine will offer
you language options. To select the required language, enter the appropriate number. The next
page allows you to select - using the cursor keys - how you want to proceed.
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- Show Readme file: this will display a file giving you more information on how to install the
DOS driver.

- Start setup: this will run the actual installation routine.
- Exit: to quit the program.

During installation, you will be asked to enter the following:
- The directory to which the driver is to be copied (normally c:\MTM), and where the “msc-

dex.exe” file is located in your system. In Windows 95 this file will normally be in the c:\win-
dows\command directory, if c:\windows is the installation directory for Windows 95.

Once you have made all the necessary entries, the required drivers will be copied into the cho-
sen directory and the program will modify your Config.sys and Autoexec.bat files (backup
copies and original files will be saved with the suffix .mtm).
Please note that having a [load “mscdex.exe”] command in the Autoexec.bat file will adverse-
ly affect Windows 95 performance. For Windows 95, therefore, we recommend deactivating
this command by entering “rem” in the appropriate line and transferring the original entry to
the dosstart.bat file, which you can find in the Windows directory. Dosstart.bat is activated
when you shut down Windows and restart to DOS.
If you want to run the recorder at the genuine DOS level (not via the Windows 95 DOS box),
quit Windows 95 to DOS, or boot your PC and call up the boot menu (press F8 when the
“Starting Windows 95...” message appears. Chose the Option “Command prompt only”.

9.2 DOS driver SCSI installation

Since the installation of the DOS driver depends on the SCSI controller used, please consult
your controller manual for instructions on how to install the DOS drivers.
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